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1. Department Creation
a. Department Creation
Navigation
Administration -> Institution -> Select intuition from which you need to create department -

>click department bottom of that intuition -> click + Add New for Create new Department ->
provide the data and click save

Code Mame Type

Extatlizned Date Dizzlay Drdar

b. Already added Department list find

Navigation

Administration -> Institution -> Select intuition from which you need to create department -

>click department bottom of that intuition -> you will find out the department list already
added

13 famputer Apziicstic

Academiz

*  Code Name Type Action
1 Aecounting & Fraccs Zccounting @ Finatce Zzademiz o O s
1 BLOM-A0D B.COM (ADD} Acsdamic .;
3 3us Zacmalzraf Marazemer: Srudas lzadamiz z
4 3Temezdl 20ame321 Aesdemis
5 2Com-Ca 2Com-CA Acedamiz m
8 BCom-CS 2Com-CS Azedemc -
7 200maT A i cic |
2 2lom-PA o m
] Ziotecknslozy 3
10 3uzmess Zdminiztator Azadamiz .~ m
1t Iizcesztezzes: Serczes Aazizmic s
32 Catering Science & Hiotal Mansgemant Acsdamic
13 Chemistry Crmamitey Azademe -
14 Commerse Commerze Acsdama .

. EA

Mext
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2. Programme Creation

a. Already added Department list find
Navigation

Administration -> Institution -> Select intuition from which you need to create department -
>click department bottom of that intuition -> you will find out the department list already
added -> Click the Programs -> You will find the already added degree program list.

Duration Action |

b. Already added Department list find
Navigation

Administration -> Institution -> Select intuition from which you need to create department -
>click department bottom of that intuition -> you will find out the department list already
added -> Click the Programs -> click +Add new -> Provide the degree Program details -> click
save.

Total Sest Manszement Seat AICTE Codz

Short Description

Iz Active Prozram

c. Working hour adding for program
Navigation
Administration -> Institution -> Select intuition from which you need to create department -

>click department bottom of that intuition -> you will find out the department list already
added -> Click the Programs -> click working Hours -> Choose the necessary field and click

save

& COLLEGE
i(angayan*.—%"_a 108.
. Taminady, indi2.
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| Working Hour - Accounting & Finance {
|
|

Bl = Aczdemicfaar * Working Hour Staff Type
i
| un 2029-Jun 202 v Cheose Wo zHo ¥ ~ Chacsa Staff Type v H

< TR Lan e i
* Effactiva Date Effactive To Data {
{

Lesar

{Orking mours {
|
» Werking Hour Staff Typ= Effactive Date Effactive To Date - Actions i
: i

2 Steff_TE » 01/04/2317 35/08/2017 F o
2 TE_E#afF 171052017 Z = |
{

3. Academic Year Creation
a. Find out already added academic year details

Navigation

Master -> Academic Year ->find the institution -> you will find the academic year details
which is already added

b. To create New Academic Year

Navigation

Master -> Academic Year -> find the institution -> you will find the academic year details
which is already added -> click + button -> provide the academic year details and click save
changes -> Generate student day attendance after time table configuration done.

Aveon Infotech Pvt Lt
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. New Academic Year

ol
5 Academic Year Detail | Admission Year
it ‘
| *Start Date * End Date Education Year Code Description
2 & o

b Semester

I startDate End Date Semester No Academic Term
3 ' = = - Academic Term - v
El

| Code Name Due date for result update Topic Coverage Grace Days
5 ' l & ac =
i = -
3

Topic Coverage Grace Date

e

Semester Details

No Records found.

RS SR =g v e TN Ol
1

4. Academic Year semester Creation
a. Find out already added academic year semester details
Navigation
Master -> Academic Year -> find the institution -> you will find the academic year semester
details which is already added

b. To create a new Academic Year selection

Navigation

Master -> Academic Year -> find the institution -> you will find the academic year details
which is already added -> click + button -> provide the academic year details and click save
changes -> Generate student day attendance after time table configuration done.
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| Jun2019-Jun 2020 ‘

Academic fear Detail Adrnizsion faar

ul

EndD Description
2013 g0} 2
od Semester
2 startDate End Date Semastertle Azzdemic Term
(] fa ~hcademic Term — v
| Cods2 Hams Du= dat= for resuit updats Topic Coversze Grace Dayz
=
is
3
Togic Caversz= Grace Date
-
3 Semester Details
iz
| Start End Semester Academic Dus date for rezult Topic Coverage Grace  Topic Coveraze Grace
Date Date Mo Tarm Code Name updsate Dsys Date Action
e 2
1 Semastar 02T 0o AT 3
¢ 2 Semester EVEN EVER |
4
cene e Student Day Aandance | ERLUTRGILI RS | Dalste | Caneal i
|

5. Regulation Creation
a. Find out already added Regulation details

Navigation

Master -> Regulation -> you will find the Regulation details which is already added

b. Find out already added Regulation details
Navigation

Master -> Regulation -> you will find the Regulation details which is already added -> click
add Regulation

1gayam-638 108,
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| DezresProgram Frar Code No. Of Samezters

Semester

6. Batch Creation
a. Find out already added Batch Details
Navigation

Master -> Batch -> Select institution -> Select Program -> you will find the batch details
already added for selected program

b. Edit Batch Details for Add class , Assign Tutor, add working hour, student class
allocation

Navigation

Master -> Batch -> Select institution -> Select Program -> you will find the batch details
already added for selected program -> Action -> Edit -> Modify the information Add class,
Assign Tutor, add working hour, student class allocation -> save semester => update
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Semester details

{stion Start Date End Dats
EiE) v £3/08/3045 9j48/2003

Leszon Plan Approval Department

~ DesarneRE - v Zasy timetasies from previouzwarking tour?
Working hour From To
- £ v ] &
120w t3 22Nz 02 7

c. Add Batch Details

Navigation

TP K SRR R S N

Master -> Batch -> Select institution -> Select Program -> Click + Add New -> Provide the

details and click save

* From Academicf=ar

- Chiose Fram Acadamic Year v

Interview

Total Ssatz
Totsl St
Government Lateral Ssats
e iy

Enterance Oate

dera
b V0] L

Application Ead Date

Save Sateh Details first 4o zenacate Temaztar datails

" To Acsdemic Year ~ Batch Name
~ Chaase To Acsdamic Yes o v
Baich Catezory:
Active batch
Manszzment Seats GoveramaniSeatz

oy

Fitled Seats Management Regular Seats

srngaimert Re;

Datz of Commencement Date of Campletian

] i

* Rol! Ma. Prefix

Online Applicatizn End Date

* Rezulstion

- Droois Fazulsven - v

Governmant Rezuler Szatz

ManagementLateral Seats

Applization Start Date

* Suffax Length

7. Room Creation
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a. Find out already added Room Details

Navigation

Master -> Room -> you will find the room details already added

Code Name Floor Seminar Hall Building Name Actions
Al Al (Engineering Warks) Graund Floar ‘ = alock - A & @
A2 AZ (Office) Ground Floor N Block - A e
A3 A3 (Admission) Ground Floor N BIOCK ~ A o)
Ad AL (Alumni Association/MIS/QAC) Ground Floor ™ slock - A & @
A3 A3 (Visitors Roam} Ground Floor N Block - A G W@
A5 AG (IT Section/PA Room) Ground Floor N Block - A & ®
AT AT (Computer Labl) Ground Flaor N Block - A =
A3 Ag {Computer Lab2} Ground Floor N Block - A & @
AT A% [Computer L3b3) Graund Floor N Block - A Lo ol -
AL0 ALD [Computer Labd) Ground Floor N 2lock - A 2 @
All All (Computer LabS) Ground Flaor N Blogk - A (o
ALD1 AL01 {NCC) First Eloor N Block - A @& W
ALG2 A102 (CCE Store Room) First Flcar N Block - A G @
AL02 ALO2 (Phy Lab} First Floor N Block - A G @
AlDa A102 (Phy Lab} - N Block - A 7 =
shawlng 1 10 15 of 155 antries 2 3 4 5 & 7 3 E] 10 Nt

b. Add Room details

Navigation

Master -> Room -> click + Add New

Code Name Flaor Building ‘\

ode | o ~2uilding - v |

Dizplay Name Allowed baskings Depertment ShaF |

2y Hame % IsSeminarHall ared Boukings —ChooszCzparimen ¥ - Chagas Staf - A

|

Rezervation 2avz |

|

|

Occupancies | Features

Layout: Type: No. of Qczupenzy , Featuez Tatal ‘

! ) |

- Lapout— Yy + i —Occupancy Typa = t 3 {0, ot Dorapams: ' - Faztirm - b Tedal |

|

- 3 S - |

Room Qccupanciss . Room Fzaturss |
45 Room Ceiupsncies Configured Yot Na Raom Faatures Configured et

Seve Changes m areal |

c. Edit Room details

BUILDERS ENGTEERIN
athekadaiyur, Hangays ;
: Tirupur DL, rariinads, india.
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Navigation

Master -> Room -> you will find the room details already added -> Click edit -> Modify the

details -> save

< Is Seminar Hall

Reservation days

Occupancies
Layout: Type:
- Layout - ¥ B - Qccupancy Type- ¥

Room Occupancies

o Rgom Qucupancies Configured Yet

Cancel

Code Name
Al Al (Epgineering Wo
Display Name

Floor Building
rksi Gravund Fleor Block - A
Allowed bookings Departmeant Staff

~ChoosaDepa v - Choose Staff ~

Features

Mo. of Occupancy: Frature Total

Room Features

Mo Reom Features Configured Yet.

|
i

3
|
1
|
{
i
|
|
|
|
!
{
|
|
|
|
|
|
|
j

E Room Layouts

e
S nstEuiioA SriRamekrizhna College of Arts and Science -
- Cods &5 Mam= so
~ Heo. of rows . ~ No. of columns .
~Ma. of sests per columan % Total na. of = 20
Row no.  MHo. of columnsz 1 2 3 Tatelzeais
1 3 = > 5 &
2 3 & = = 8
3 3 = 5 &
2 3 = - = 8
5 3 - - . 8
Reaet
Code Naose No. of rows No. of colueraz Totalmo. of sests Action
122 133 3 32 220 &=
120 120 5 20 120 Z &
Semmater Garratec 2 3 3e s
30 30 5 3 30 =
LAz LAz 5 0 50 or =
ENDSE EHDSEM B 3 30 s
Ml <ommuon Common 2 a 38 =5

BUILDERS EN
Nathakadaiyu:

ST CRERE | =
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a. Grievance Type configuration

Navigation

Master -> Grievance Types -> you will find the Grievance type already added -> Click + Add
New -> Provide the details -> save

! B Category Code Catezory Description Action

1 cos coz g

b. Grievance Type Modification

Navigation

Master -> Grievance Types -> you will find the Grievance type already added -> Click edit ->
modify the details -> save

Category
Category Coda Catagory Description

COE | COE @ Active

Sub Category

# Sub Catzgory Code Sub Category Description Active

1

N
aoo

c. Add Grievance

Navigation

Master -> manage Complaints -> You will find the complaint details already added with
complaint status -> if you wants to add a new complaint click + Add new

AL

NG COLLEGE
gayam-638 108.
du, india.
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#  Complaintid Grievance Category Desc Complaint Subject Complaint Done by Status Reason

*Salact Grievence Category

fee]3 ¥
*Sub Category

-~ select sub category A

Exam Application
Result
General

“Subject

ter the sublect

“Description

d. Update Grievance status

Navigation

Master -> Complaint status -> You will find the complaint details already added with
complaint status -> provide the details search -> update the status

Complaints Status

From dsts Todste

nLoLTete (] 13/5242020

Panding
Comalated
Cascal
Rscizvad
Aazignes

Complaints Request Deatils

1é Date Subject

Irproges

9. Seminar Hall Booking

a. Hall Booking

Navigation

PERIN

BUILDERS ENGINEER!

Nathakadaiyur, Kanoayam-638 108.
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Academic -> Seminar hall booking -> select the date -> Provide the information -> saves

Bl - February 2020 i w<>

Sun Mon Tus= Wed Thu X Fri Sat
25 27 25 Slatiigee

s e ZiEn s i e s
; m“%mﬂm‘  8:10 Semivar [ €42 | 86 GUEST LECTURE | 8:401 it et
ST Gt | aetiirs: 1§ Set Phalatulin 5 || 8a intra dep a2 o

e {5 { s2m ST EECTU

Sook Hall!

R

Seminar Hall Booking S

~ Department *EventCode =~ Event Name
infarmation Technology Y oode . t >«=‘,.: ‘
~ Start Date & Time " End Dotz &Time Audiznce Strenzth: “Hsll
I «,-,.:».:";,’\-, Rhirs & P} e yyy hivrm o ] [ Entaraudiznos sbenzia o | «Chua::?':‘ﬂ—- . v
Sezzion: Remarks
. Y:
CClear | X {Iancel

b. Hall Booking Approval

Navigation

Academic -> Seminar hall booking Approval -> select the date ->search -> click approve or
reject ->saves

ICIPAL
ENGINEERING COLLEGE
Nathakadaivur, Kangayam-638 108.
Tirenr Dt Tamilnadu, india.
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- Seminar Hall Booking Approval Search

Search

Seminar Ha[lBoo(dng Rec‘nylmt

Therz iz ne pending seminart sil2ockinslist for appravel

Lome

beck sfte:

10. Holiday Creation

a. Holiday Creation

NavigationA

Mater ->Holiday ->select Institution -> Click on holiday name -> provide the holiday details -

>saves

~ Institution
f S gamsl;'i;;t;g“éollegeﬁélb and 3uencs v Generste
Holiday
Code Neme Effectiva Date Effective Throuzh Date Actizas
Enlart) 314pr 2018 = P& ]
z4(5) 312pr20tE 2HE30
FRlALL} Fastisi=s qrapr2018 Bro
FHS) Festival raliday (Student] 01Apr 2018 BE0
Sstuzay Saturday 212prI015 BE0
Aveon Ipfotect Pyt id Page 17
o )
&
] wh = 3
i ‘.\GP*\{?‘ o) e
St Rl AL
2\ 6% BUILDERS ENGY!_ZRING COLLEGE
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Codz Name Effzctiva Date EHactive Through Date Actions
e 22 AprIo18 - =B 0
= T : @Bmn
=3 y (Stuzes 2 2pr2018 - =3
Saturssy Ssturday 314pri015 - BED
Holiday Detaills) |
i
S.Ho ~Dezcription *5tart Date *End Date Actionz |

.
#

EENCEEEEEE
VSIS IS IS IS R R
Qo@oo@oaa

[et)at i i N
) SN  Ganerate il

i
| Holiday Exception - 5irick i
¥ i
g f
| S.No *Employ=eType Actions
I l — Cheose Employe=s Tyr ¥ Fadd
NON-TEACHING

& TEACHING

i Teaching Aszistant !
Tamp Nan Teaching Cloze |
8 v

5

11. Student staff Thoughts

a. Student Staff Thought Creation

Navigation

Mater ->Student Staff Thought ->select Institution -> Click + Add new -> provide your details
->saves

BUILDERS
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From Date To Date

07/02/2020 =] 14/02/2020 =]

Complaint Details

No recards found

Staff Code [ RoliNo Name " Department
TEVER VIJAYARUMAR Y ces
Feedback
From Date Ta Date Review Dats
- Py -
Remarks
B o

12. Staff Management

a. Already Added Staff details & edit Staff Information

Navigation

Human Resource -> Staff Management ->select Institution -> Select Department -> you will
find the staff details already added in select department

BUILDERS ENCINZERING COLLEGE
Nathakadaiyur, Kangayam-638 108.
Tirupur Dt., Tamilnadu, India,
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i G AT

HLA URECE /| STASF MANAGEMENT SMATHERA

| sTarr ManacEvENT

MUTHUMANI N (TEDZ2)

Seaft Type TEACHING
Employee Code ¢ 23
Staf koie i HEADOFDEZA..
@ = 5 =]
Conmact Identity Waork Profitz Irofaszional Prefile
Academic Profila Details
Tima Tabiz Subjects Handlad

Library Books Rented

o + 5 g O i
Qe CF Birth 24-Aug-1977 Dom Of loinng
Cender Szmals arival Seatus
Designation Hlosd Groun

Pubfication/Achizvements/ Mambsrship

Ei i

Syllabus & Lzsson Plan

l”

intarnal Result

10-13n-2008

Extarnal Rasult

HUMAN RESOUl S Code Sraf Typs Staff Role *
IR TA-Teaching Assstant vl Faculy v
| sTarr mA e
First Mamnz * Last Name™*
( ¥ | KOMAGAL' || s«
| )
| Dasignation * Datz ¢f teining * 2018
B :
Date of Sith * sitive
1 | 26081928 URRTY v
| : :
!‘ Email Id Mcooile Number * m
o7 S i . - .
Contact ; sennzeT ‘ nic Profile
— X £ - E
Contact| Maritzl Status Zlocd Group ‘
* S— S— - L2
| v v
Mo records o . B e St B —
!
5
- e Sy i e i

R EYEkm
38 108.

BUILDERS Eye)
Nathakadas’yur, Kaj
Tirupur Dt 1

==
adback

Fe:

ie

: IG COLLEGE
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b. Add New Staff Details

Navigation

Human Resource -> Staff Management ->select Institution -> Select Department ->
Provide the staff information -> Click save

taff Type * Staff Rele *
v L 4
Salutation ™ First Name Last Name ™
v
Designation * Date of Joining ™ Gender *
Date of Birth ™ Employee Cade ™ Pay Type ™
==] | v
Email Id Mobile Numbar * Emerancy Moo, Number *
i Marital Status Blood Group ™
v T
WETE ™ iziid i U it L T

Na

ithakadaiy
Tirupur Dt

rangayam-638 108,
iamilnadu, India,
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13. Staff Complete Profile

Navigation
Silver light Payroll -> Transaction -> Select Institution -> Select Department -> .select Staff -
>you will find the staff General Information, Academic Details like timetable, subject

handling details, Syllabus, results, attendance in/out details, daily attendance details, Leave
& Permission details , Salary details, Certificate details etc.,

14. Staff Leave Apply
a. Staff Leave Apply
Navigation

Payroll -> Staff Leave apply ->Select Current payroll Year -> click Apply new Leave-> select
leave type -> provide date-> Make alteration -> apply

Payroll Year

| Jan2018-Dec2019 Y

No Recent Leava details found!
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Lesve  Max Approved Pending  Leave Available

e - Hali day Bl v Type Dayz Days Appraval  Taken Days
’ Days
Leave from datz Lesve todate Ressonforbaave Casusl 12 8 7 b 12
&l ] e
omp 3 2

Leava Holiday Total Avsilable

o

Days

=

- - - 3
) o) s 3
P A A - o
speciel - . ¥ ~
oD
oo
9 \ 3 b

15 Staff Leave Approval

b. Staff Leave Approval

Navigation

Payroll -> Staff Leave Approval -> you will find out the list of applied leave by staff -> select
the staff leave -> click Approve

BUILDERS ENGINEERING COLLEGE
Nathakadaiy.ir, Kangayam-638 143,

Tirnir N Tamilnads leddia
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SNo Staff Department Requested Leavedetail Place Of Reazon Status Actionz
on Duty

1 Comp OF{5ep 20,2913 ) L day fo visiz ailing motharin-law Bl ~iianie

5 ey

3 visit oy siling mothanindaw G

4 3 visitmy siling mothar W Ao~

= JUl3L,2018 Casusliesve Jur 12,2013} 2 day 3

3 24,2048 On Duty {lul 24,2023 50 Jul 25,2018] 2 FOP or "Intrsduciion to PHP Programming” atsackers collze,

<ays che
7 Auz 23, On Duty[4ug23,2013 L de 332 1T students to AEFSL forworkshepon ' sctiors v
245 ylm8g ¢ f " fctiors v

2018

3 32003, CazuslLaswe | Az 31 20130
08 ARzrNeosn

2 0ct 15,2008 Comp OF{Ock13, 2013 ) Half Day- sizk

b L 0ct 27,2018 )2 Principa

3 Niye Maril, On Duty{Mar12,2013 ) 1 dey 31 Sxam

M 2018

15. Staff Permission Apply

a. Staff Permission Apply

Navigation

Payroll -> Staff Leave apply -> click New-> provide date-> Select Permission type -> Make
alteration -> apply

RUILDERY ENZINELRING COLLEGE
Nathakadaiyur, Kengayam-638 108,
Tirupur DL, amiinaduy, India.
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Permission Apply

* Date ~Type

*From time

16. Staff Permission Approval

a. Staff Permission Approval

Navigation

Payroll -> Staff Permission Approval -> you will find out the list of applied permission by staff
-> select the staff permission -> click Approve ‘

Mo pending permission requests avsilable!

17. Candidate Enquiry
a. Enquiry Adding

Navigation

Admission ->Candidate Enquiry -> you will find out the list of already enquired student list -
>add -> Provide the candidate information -> Save

G C
Nathaxada:yur Kanqa):am GgJSL %E)SE

Tirupur Dt »Tamilnadu, ndia.
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Candidate Enquiry

- Basic Details

Application No ™ First Name ™ Last Name ~
3>
P
Gancer” Blood Group
T 3 \
Maother Tongue Naticnality © Religion Community *
) 3 : 4 v v
Caste Sub Caste Mobile Number Email-id
L |
J
~~~~~~~~~~~~~~~~~~~~~~~~~ -~ Parent Details y ( Address Details
Addrass 1 Sddrass 2
Type  First Name Last Name Mobile Number Action
Father P ra
- City Pin Code
Mather & { & -
(— Qualification Details D Add
Course Type Education Type Beard Medium Register No Mark Action
v v v v '
v v v | v &
v : v v ' s
Course Preference Details O Add
Admission Type Admission Category * Scholarship Category Remarks
= = | First Graduate? =
Reference Type ™ Route
= l_:] B Uastellar Shift Course Category Course / Program Action
Bus stop Atleast add one course / program

Clear

b. Candidate follow up

Navigation

Admission -> Candidate Enquiry -> you will find out the list of already enquired student list -
> Edit the candidate list -> click follow ups -> provide the details -> save

Aveon Infot

T ]
frupur D¢



CMS Application User Manual | {CMS)

D2scrigtion
ks
i
ay
G: Naxz Enguiny Datz & Tims
|
a
|
k|

c. Candidate Payment

Navigation

Mode of Enquiry *

Dirscr ¥

"

Admission -> Candidate Enquiry -> you will find out the list of already enquired student list -
> Edit the candidate list-> click Add payment -> provide the details -> save

Payment Date *

113

Chegque / DD Number

Receipt Details
Receipt No.
SNR/CAD/13-20/2839

Payment Methad ™

Advance Fez Type *

Date
14, Feb 2020

d. Candidate to Student Conversation

Navigation

T R

Aveop/tnfotech PVELE
L%"
K ANGAYAM)
538 108.

Sma st

*393‘\’\0 =

TS

Amount *

Chegue 7 DD Date

pogel
Amount Print
10000 A

Page 27
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Admission -> Candidate Enquiry -> you will find out the list of already enquired student list -
>in action convert student ->select the details ->convert the student

Apo o, Candidatz Nams fear Mopile No. Adrmszior

2 v isAdminad?
30 razuits 20
App 12th Reg 12th Parant Candidate Return
Enquiry Datz No. Name No. Mark Mobilz Mebile Antendad By Advanca Amount Remark
4 4
13-02-2020 0242 VIGNESH B 30552432 G 00
13-02-2020 232 ASHWING 5 0 SUNA EEELA P23~ 2 c
A
2-2020 0228 SRIKANNAN R GUNA RAZH 000 Za
K st
3-2020 013¢é NESHG 9582823332 CLINA SEELA SRAB=U 10000 Add Snaui
225 RAMA GUNA SEELA 2RAZEU 10000 -
0185  AMTHRUMARS | | G03264073 8333362439  GUNASE TLA SRASSL 00 PR

19 Student Management

a. Student details modification

Navigation

Admission ->Student Management ->Select institution ->Degree Program-> Batch -> you will
find out the list of already added student list ->in action -> View ->Modify the details ->Save

Aveon lnf?tf
{’i!
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23t n Tyes Fina Categon
T v v ¥
4 oo, rt O
m PN > 3 3
v o~
Oz rh N .
c al iszizn D32 ASREEAN
v a1 v
d Grovs R
loin Catz Rafzrry 2 Rofarra i
v — —
vi + |
2 Tangue ma d Langua
r Firzt Nams L35t Mame
v ¥
lit
s 4 ':tvl o
v
Reigien Community * Casme

b. Student Disciplinary Actions

Navigation

Admission ->Student Disciplinary Actions ->Select institution -> Program-> you will find out
the list of already added student list -> + Add New -> select batch-> student -> Action type
details -> save

c. Student Certificate request configuration

Navigation

Admission -> Certificate approval Configuration ->Select institution -> select certificate type -
> select approval staff details ->saves

AL
iG COLLEGE

BUILDERS
¢ gayam-638 108.

Nathakadaiyur, ‘
Tirupur Dt Tamilnady, India.
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{azuz Date Reamark

Cancel

d.Student complete details

Navigation

Admission -> Student complete detail ->Select institution -> select program -> select batch->
Choose student -> now you can view students general information, Admission details,
Address details, Certificate details, attendance details, CIA/CE mark details, Library book
taken details, fees details etc.,

=1
-l

L]

i
%\. !

BUILDERS E
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Genaral Admizzion Address Certificats Attendance Mark tibrary Online Bxam Conduct Scholarship
Overall Atéendancs Subject Wise Clazz Pariod Wize Cumalative Attendance 1| 2 5 3
- SubjectCode  Subject Mame TotalHez  PresentHrs entHez  ODHez  Present?s  Abzent® 0D %
3 .
75 &5 43 -
5 i 3 . .
=y s s 2 3
73 13 - 83.53 -
25 33 2 -
Summary
Clazs Advizar: MAT)
TotslHez: 51t PresentHrzt 423 0D Hrz: -
Prezent 3 3378 oD 3%: -
Ganarsl Admizzion Address Certificate Attendance Mark Library Online Exam Condust Fees Schotarzhip
Internal Result Clazs{Cycle Test Semester Rezult Sem e d 3 4 3 g
Semester-1
- SubjeciCode SubjectMame Internat Mark Externai Mark Grade Grade Point Status
1 2 a3 3 i3 Sas
2 2t 42 2 35 Tax
3 15 53 ¢ a3 San
3 24 EH o= is S
s < . s “ -
s 12 4 ~ 89 Raz
3 % 74 ie T4 Pasz
15 - . -

LDERS ENGINEERING COLLEGE
Nathakadaiyur, i{angayam-638 108.
Tirupur Dt., Temiinadu, india.
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General Admizsion Address Certificate Attendance Mack Library Online Exam Conduct Fees Scholasship

Internal Rezult Clazs/Cycle Test Semester Rezuit Semester

&l Year CIA 1

e SubjectCode Subject Mame Min Mark Max Mark Obtainad Mark Firzt Mark Status
1 ITFSL Frasch~ 3 3% ] b Tail
2 17E0L Eaglize 12 3 1 Pt Pau
3 A7BAENL Prosz 12 32 2 b Fas
< 1v3Az02 Fictol 12 3T 3 2 Pa

3 12 30 13 = Say
Model Exam (1 Year]

. SubjectCode Subject Name Min Mark Max Mark Obtainad Mark First Mark Status

1 17701 20 5¢ 28 <2 Paz;

2 17E02 Soglsh 20 50 33 42 Sazz

3 1TBAEL01 Proze-| 20 30 = = Sau

2 17348102 Tizwen 20 50 2z a0 Sazs

3 1T3AEL03 20 30 pis a3 Pax

é 17ES0L 32 a0 < 33 Pz
General Admizzion Address Certificate Attendancs Mark Library QOnline Exam Conduct Feez Schelarzhip

*  Accino. Baok title Izsued date Exp.return date Fine Amount Returned date No. Gf Renewst Statuz

1 18547 COMMUMICATION SXILLS A MULTI SRILLSQURSE . m

2 37441 . s

3 357 é &=

e.Student late Register

Navigation

Admission -> Student late Slip ->Search student by Roll number/register number or name ->
provide date and time-> reason

Aveon Infote/c;hi]_&?’“ §
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NCADERIC
Add Subjects Subject Department” : T

Add Subject Add Regulation Subjact

Lodat Namez Cradiz Scint Sort Qrder* Classification
v v
Subszer Typz™ Suject Classification * Subjec CStzgory ? Elective Group From Date* ToDst=z
T v v v . 5
Akpravigtion From Dae ® FoDaz Azademic Tarm
- - v s Fastirack Courzz
Yiark Dafintion ® Topic Covarags* Lezson Plan Approval Dem Aim Coizone
T v
Subizer Part Board
v v
=cftaicd LPenod TPericd arics wrcd [ Wask
Mark Definition Detals:
Min Mark: Intarnal Min Mark: Extzrnal Min Mark :
Max Mark: Internal Max Mark Sxtarnal Max Mark:

(24 \1
BUILDERS EN G COLLEGE
Nathakadaiyur, Kzngayam-638 108.
Tirupur Dt Tamitnady, india.
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20.Subject Details adding

a. Import Subject Entry.
b. Import Syllabus Entry.
c. Import Regulation Entry

Navigation

Academic -> Import Regulation subject ->Select institution -> Regulation -> select the excel
file ->click next '

d. Single Subject Entry

Navigation

Academic ->Add subject ->select department ->provide subject details, unit details, subject
staff details ->click save

e. Subject Approval sending to COE Approval

Navigation

Academic ->Course summary ->academic Year ->provide semester -> department ->

programme -> search -> go to action on list -> click course details ->verify the subject details
-> approve / reject

f. Subject Adding from Tutor login

Navigation

Academic ->Course summary ->academic Year ->provide semester -> department ->
programme -> search -> go to action on list -> click course details ->Add the subject details -
> submit the subject for COE Approval




CMS Application User Manual | {CMS)

g. Open Elective Subject Creation

Navigation

Academic ->Open elective-> Add course -> provide the subject details, staff details-> save

75} and Students Tor Investment Literacy

Teaching Staff(s) [1]

¢ Staff Role Total Periods Date Actionz
1 NOVINASTEFFYJ Main Staff a4 13/05/2023 to 2271172013
Students [24]
* * RollNo Student Name Action
£ 17101043
2 17401022
3 I 1704027 3
1 B 17101090
. e
5 B 17102001 ABDULRARMAN S 2
§ @ 1702008 ASHOKAUMAZ M ‘
T 17107027 MALARAVAN D
3 ) 17192031 MOHAMMED RLISSAIM M ;
3 B 17102034 MUSTAFA O3MAN AHMED CA

4

e — e

h. Choice based Credit system Creation

Navigation

%»CBCS -> Add course -> provide the subject details, staff details-> save
N

Page 35
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Choice Based Credit System | Add course |

s B‘( Cl (‘I:utal. " "@@,‘lr'éml“v énm_{"’ i)

# Course Code Course Name credits semester Joined Actions
1 18COAZ03 Company Law a 01 m
2 17COA202 Financial Management 3 110 = Manage Teaching Staffs
o7 Edit —
# Course Code Course Namea credits Semester Joined Actions
>3 17TITCOS Computar Netwarks 110 | action ~ |
2 16CECO3 sava Programming 4 109 m
3 18CSCO8 Java Programming Lab 4 100
Home | Acsademic £acs Jun I013~Jun 2020- 002
Choice Based Credit System | it coure |

L] Courze Code Course Name Credits Semestar Joined Actions

b 17COACH3 Strrzazic Varzzement 1 5 19  acsion « |

£ Course Codz Course Name Creditz Semester Joined Actions
2 170811 2,tron Frazramming 3 H EaT) m
2 1728012 2ytten Sragramming Las H B 108 m
3 37Ces ac3Ms 3 3 143
4 231TCC5 caMs 3 3 18 m
H L3ITC04 333M5Les 2 3 128 m
] L3TC04 3o3uSLen ] 3 1z m

Open elective subject selection form Student login
Choice based Credit system subject selection from student login

| S

| OPEN ELECTIVE 7 CBCS

OE Subject  CBCS Subject

Open elective subjects records not found.

age 36
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21.Time table Creation

Navigation

Academic ->Time Table -> Select institution -> Academic Year->Semester ->Choose the class
-> Config the timetable -> Generate the time table

22.Subject card / LMS

Navigation

Academic ->Subject card -> you will find out the subject details which you are handling
current semester -> go to action -> you can do lesson plan, mark student attendance, create
assignment and allocation to student, internal mark entry, conducting online exam,
conducting stay back and special classes, study material upload, conducting feedback &
OBE mapping
a. Subject card

b. LMS Menu

C.

d. material upload

Lesson plan creation

l"'l;": 4
Bl nEGe
BUILDERS EN
Naihakadaiyur,

yam-638 108,
Tirupur Dt.,7

dy, india.
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|
W2 Tegiz/ SubTopic: Introductory Concepts: How to dewelop a program
— 3 s . 3 =
| Teaching Mzthed zzching Aid Refzrancz No Rasource Type
kT 7 KCheose] ¥ [Thoos=] v
Lecturs | ¥
} . . ‘ |
. Jo| | GroupDiscussion ;T: a
2 Zzminar i
ctory Quiz pe ) Expzcted on
Taam Tzachin
o 3 g 5 N = |
ction § Exparimzntzl ¥ A ¢ 5 § ]
! Anslysiz - - -
pes, Ci Expasimantzl Deme i b 4 Ll
! Exgpzrimantal Fractics Sk o
Dﬁdj Online E-Flling
Expzrimantal Techniguz

g E=mEn

35 8 FERTSSEARE BRTRRBHE AREATnr TIAEry AreratArs RRERARS] ARarstare T s o e e e

e. lesson plan approval

f. Student attendance Search

an:h Attendance

i
b Curstion

Currantwesk -

i Currznzwesk
Last 7 days

i Bravious wask 4
‘ ; Currznz month i
| Sravicus month

Otharrzngz

| -
i

Infrtech By
638 108.

Natha

it Ln 7
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ACADEMIC - SUBLELTS y FROGRAMMING N WITH LAB ATTE

SEARCH RESULTS

7 Date Period Day Details Division Batch Attendance Status Topic Coverage Status
11, Fe0 2020 . Day Order 3 Bragramming in Cwith Leo - 13 5CTT - NotFastad
12 Fep 2020 v Day Crder § Programming in Cwith Lag -1 85CT - Mot Posted
13, Fe5 2020 ! Cay Crder 1 Programming in Cwizh Lag - 135017 - Mot Posted
13, F2p 2020 it Cay Order 1 Programming in Cwith La5 -1 35C T = Mot Pasted
13, Fab 2029 I Day Order 1 frogramming in Cwith Lss -1 35C1T = Kot Pastad

NON CLASS LIST

(D Moz Posted List I Lozd Al s

Mo rezord found,

g. student Attendance Posting

Manzgze Teaching Staffjs) and Students for Python Programming

Section A Section 3 +* =3

Tesching Staf) (1

#  Staff Total Periods Date Actions

1 MUKUNTHAN B 12/06/2043 to 227212019 @@

Students [44]

RollHe Student Name Action

17106004 ARUNY = Hections

| 17105005 ASHOK VAN R
@ 17106007 SAINDHAP

1708002 Sachons

17108040

Lhsnpr Sthicea
17108043 TANATHR!
17108015 GOWTHAM R
17406047 HARIKAISHNAN M

17106023 JOSHUVASBINRAIM jor
17106024 HAMALESH J Zacti
17106025 KARTHIKEYAM 5 ‘ o

MAMIMEGALAI D

MOHAMED RIVA, g Secti

y IPAL
NZERING COLLEGF
Nathakadaiyur, Kangayam-638 1%%‘5.5

Tirupur Dt Tamilnady, india.
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h. student Attendance cancel

i. Assignment Creation

1 Tz
i
- __i
! Dascription

| i dark

¥ S

ki s paidl vk b R

i i R
i

i | Fubrics* Iz Point ™ ‘
; 7 __" = ; i) i 4
£ Dasmpnon | Na racords found i
R, ey et e s —4[ Bl - - e ( : )
| £
st | l [
Min. Mark Ma Mark ©
q0 1 | 3 3
q L EA Al SO s U ¥
ﬂmgnn*ﬁn Da= Y FS TusCat A S
q | A T EE o i [.w] = RN
e e N T e | arisil? = e o= — v P — G
* v L4 L4 !
% 0<> # Assign Rubrics O Belzer Al Studants
i

/& e
{L KPNGAYAM

4, E
BUILDERS D\U.NEL‘%NG COLLEGE

Nathakadaiyur, & “zrzc;am-638 108.
Tirupur DL, ‘arﬁ.iradu india.
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j.  Stay back and Special Class Creation

k. Internal Creation

23.Staff Change

Navigation

Internal Type * v

Mams

Academic ->Staff Change ->Class wise /Staff wise /Exam — Class Arrangement can done

Page 41
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24.Student Leave Apply

Navigation

Academic ->student leave -> select institution -> Academic year -> semester -> class -> select leave type -> select
student -> Apply Leave

Leave Apply

Lezve Typs From Date To Date

13/02/2020 01:00 PM & |
Reszon
tly Abzent Students . .‘_:_ “ -T:;,-_.; -
Session: Hourly * FullDsy  ARerMoon — ForeNoon
Search Studants
Reg No. Roll No. Name -

13107001 13107001

12207005 13107005

13107005 19107005 ARAIND KUMARR

‘: m C".'::}

T e R

T BVl it O

BUILDERS
Nathakadaiy

Tirupur Dt Tamiinady, india.
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25.Circular

Navigation

Academic ->Circular -> select institution -> Provide the circular details -> choose the Department -> etc -> save.

a. Create acircular

b. Circular list & upload the files for the circular

v 13762/2020 & Vieer

Cirzular Now Cirzular Date DisplayFrem Dizplay To Title Dezcription Upload Actisns

Pri<s £3-02-202C 03-02-202¢ 25-02-2020 3 Tset

.
!
1
;

"

4

123

183

i

Cancal

26.Event
Navigation

Academic ->Event -> select institution -> Provide the event details -> make Class arrangement -> save

a. EventCreation

Avg h Pvt Ltd Page 43
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~From Dat=

Review

* Dezcristion

" To Dazz

<*Typ=
~Type~

* Dizplay Start Dste

Regiztstion Last Date

. Maadatory

th

(1 insidelnstitution

) Inzide Compuz

> | Selected Bateh

Student

Student

oy o My

Al Mo,

Contact No.

*Contact No.

Emailld

Aveon Info

Nathakadaiyur, Kangayam-638 108
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B. Class Arrangement

27.Tutor Ward System

Navigation

Academic ->Student Tutor -> Tutor View-> + add Tutor => select department => choose staff => provide Date=>
save

a. Add Tutor

Wardz View TuteeVisve

« Show Al Tuters o Add Ttor:

‘Computer Applications (1)
i " Tutor Viard Count Max # of Students Date Perind Actions
i SUMATHIV 25 30 24 Jun, 2015 Actions v
i 3 )
b. Add Ward

c. Change Tutor or Ward

i :{
Nathakadaiyur, {<zngayam-638 108.
Tirupur B, Tamilnady, India.
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c
=
>
F
s
3
o
i !
na
i
g
=
-t

* Tutar: SUNATHIV

- Photo Roll No. Student Name

m 13113001 AL=AYAR

v

13153002 AISWARYA K

4
"‘i

G0 &

|
|
|
{
i
4

5 o 13115003 AMSHEY ARISENA G |
v |
g ﬁ 13113007 ARRTHIJENET & |
|
o o
i 5 i
7 g 13115003 BALASTAVINRAIC M {
‘ -y
i
z 2ei3cn 2o02a sy i
3 % 1912500 BOGBALS il
a 3 @ 13123020 CEEPIMAD
8 m

28.0BE (Out Come based Education )

Navigation

Academic ->Outcome Mapping -> select institution -> Regulation -> Degree Program->

Navigation

Academic ->0Outcome Mapping -> select institution -> Regulation -> Degree Program-> subject

Aveon lnfotqp

!
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29.polling

Navigation

Academic ->polling -> Config polling -> Save

* Polling Code * Start Data
WAMAYAR MANDRAM 2013-21012 | 23/07/2018 12:09 A o]
*EndDats * Max Mommntmn limit * Max Vate Limit for Uzser

24/07/2043 04:00 M P 100 1

* Poli Daseri, ptmn

MAMAYAR MANDRAM 208

Homines Eligible
= Code Name Dezcription Lists Voters Siari Date £nd Dats Actions
1 CHAIRMAN CTHAIRMAN MANAVAR MAKDRAM ELECTION 2013-15 - CHAIRMAN Haminess Lisz  Zhgi 2I/07/2008 0130 PM =
2 VICECHARMAN VICECHAIRMAN  MANAYAR MANDRA! 1ON 2023-15 -VICECHAIRMAN  Naminess List  Zhgl Zs
3 SECRETARY SEZCRITARY MANAVAR MANDRAM ZLECTION 2013-15 - SECRETARY Nominess Lisk Eligh 28:00AM s
4 JOINT JOINT MAMAVAR MANDRAM ELECTION 2013-L8- JOINT 240772013 C3:C0 AN Zs
SECRETARY SECRETARY SECRETARY

30.Student Login

a. Complaint Register

CMS / Masierw | Admission v - Acsdemicy | Hoselw | liwargw  Fesdbeckw Feew ' Atend Online Evam.

+ Complaintld Gricvancs Catezory Desc Complaint Subject Complaint Done by States Resson Action

Aveon Infote¢ td Ga Page 47
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b. Profile Edit

FirstName Lazi Name T Astharid
SZHINATA 1 8780824782 ¢ -
Relrise Zammunity (S tatienzlity
el ¥ s v AGAMUDAYAR e v
Farnsedame Eatnaraige Father's Oczuzstion Fathee'z dnausl lazsme
i ¥ THAEARA L Date a8
i Mathardame Vorrers Az Mather Gecupstion Motner 2amuslineame
Insert Image Here !
MAN NEQALALT 1 BUSINESS
Mothes Tangue Flace OF Bieen BazzportMo. Saszpont Buued Place Pazzportissus Dste Pazmport Beoiry Date
Tarmii v Tirugur | Praapar b axapoet lwod Plocs | g o & 3
Visa Yo Visa lsaued Plsce Wi lmued Date \isa Exgiry Dste Vizs Type Viza Zntry Tyoe
- 47NN - | -ohasse- v - Chaase- ¥
LenzuszzSutject
R ¥ Fhysizaily Tarlanzes | Andseyen NicabarNative Vizusily Chalienzed L ParentZx Service Yan

¢. Poll Voting

Currently there are no active Polling{s) available / You have voted for all Position(s).

d. View Circular

Circular sestonusrdesis : Paxe Cirzular

Cireular

Informatian] No circular detailz svailable.

e. Assignment upload

Nathakadaiyur, Kangayam-638 108,
Tirupur D¢, Tamilnady, India.
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f. View Event

Emaitio Dezcription

g. View Exam timetable

Semester Exgm Cetails

Internal Exam Details

Internal Exam Time Table 13-F23-2020

ClAt

f

|ABHINAYA T 17102001 E
End Time | Subject Code | Sabject Dese

[10622023 | @:30AM  1200FM | 17COARD) | Digtal Markeerg

il’x' 020 (930AM 1Z50PM | 17C0ACOS  MamagsmamAcsoumng i

[12022020 " 220AM  1200PM  TTCCAZS2 T Himan Sescume Managament

o | 1TECRCiE et Maedoey e,

h. Leave apply

Acaderic » - Hogbel v\ | Librery v Faedback = Fee » . Attend Online Exsm Profile (':) Anhinsys T
Leave Apply
“LesveTyze:
~Leave Type- I haitdey? iz Hourly?
“Session: Reasan:
~ Chocae Seazion — v

E3 - B3

i. Hostel Request application

Page 49
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Prfle (7)) AbhineyT

General profile - Step 1 0f 4 £ X i

Roil Number
17404002
Vour Mabite No
9Tsi28a130
Blood Graup
3 Pesitive \ 7
Landline Na
73183230
= Parant Guardisn Manile Mo
534132297
Agdnsr N

tEss A?_~

< Firztdame
ABHINAYA
- Emaitld
17104001 @ rcan.ncin
Rerzion
Hindu v
- Fathertlame

THYABARAL % (late)

ParentGusrdisn Decupstion

Panta.

i panno

*LestNsme

Community

3C

FLE Humser

Gender

Bamale

Nationaiity

v ndian

* MatherName

AN MEGALALT

Aoassilacome

j. Library book take

Book title
BUSINESS MATHEMATICS
2 33 BUSINZSS LAV
37455 BUSINISS NANAGEMENT

n history

ANT STATISTICS

un 25,2018

Apraz 1015

Exp. return date

Mar1s, 2513

Apr23 2013

Dec02,2048

Returned date
Mee1d,2015
Se205,2018

May02,2018

) rbbinegr

k. Feedback providing

Admission v

Aczdemic > Hoatel = Library v

Feedbeck v

Atiznd Onbioe Examy

|.  Fees Details view

BUILDERS ENG!NtEH “\JG COLLEGE
Nathakadasyur Kangayam 638 108.
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CMS  Master . Admission v | Academic = " Hodlelw | Libmry v | Fesdbock v | ‘Feew | AttendOaboefasm - |- { Profile (i)mu-nmr'

Fees sucetzespatels
3) Appliad Fee Details

Samestor - § [Totat Fee Amcunt: (0805, Total Paid Amount GHEBON, Setancr Amauert: 8] .

Semestur-2 [Totat Fee Amount: {BEON}, Tobs! Peid Amourt: B850, Satance Amosnt: ()]

@1 FeePayment Datalls

. Reciptle Paymant Datz Payment sourcs Faymant Amount [T AdvancsAmaunt {7}
L seR0T 240472087 3ar sat0 3
2 sum B 300 3
3 et () 2
& Saif 24300 2
H e 239 ]
] sef 28700 8
4 D1cE20128 Saif 130348 2

31092082 Seif 134 3

17082815 B 5408 3
® 137032018 Seif 1314 2

m. Attend online exam

Online Examination

Login

User name

‘ usErname }

Password

| passwand 1

Passcode

Page 51
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31.Dashboard

Common Academic ' Fees

A DO R ————

| Student Count ~ for All Institutions ~

i Category

|

Dagartmant

| Gander

e
i

| | BB SRCAS~1252 ) SRIFMS-1S
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Student Count ~  for All institutions «

| !
| Category i

§ Inzrtizn i
Gender
S:r..:s

Acceunting & Hrarce-180

Quoza

Mathematics 15% e,

| DagrzeTypa
| Ecarding Typs

Yaar

Admission Typs
s

| BEARBAA [A- 250 -’
| Resgicn
Zdood Group

| 'Maothar Tonguz
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Student Count = for All Institutions »

Category 1

|
{ i

i
| |
.
| ‘Scams i
| Cucta

|
|
i
| Dagra2Typs l
{ |
| Zcarding Typs !
| {

T

o F-1550 ENg M-2912

%é' AL

BUILDERS ENGHNEERING COLLEGE

Nathakadaiyur, Kengayam-638 108.
Tirupur Bt Tamiinady, India.
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Student Count~ for All Institutions ~
Catagory
| Instititon
| Dapartment
Gandar
SEus
Dagrez Typz

Sgarding Type

e Bodinsyakanue-T

Yzar

- Dhanur-1
e Gradbr -8

: Admissicn Typs

S

T

| v f
Ziood Growp

Mothar Tonguz.
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Staff Count ~ for All Institutions ~
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53t Type
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i |
1
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32.Fee Module:

Candidate Advance Receipt:

The Advance Amount paid by the Student as Candidate can be added in Candidate Advance Form.
Navigation: Fee Collection -> Transaction -> Candidate Advance Receipt -> New Receipt.

Advance Payment

* Payment date : 04/04/2022

* Payment mode : | Cash
*Cheque no:

Bankname:

* Deposit type ©

v
LS
N

! 1ig)
pe
w o
oo

Institution : BUILDERS ENGINEERING COL “AssetAfc:
“Chegqusdats

- (+

Remark :

Fee details :

Course Fee type

Fee type |

Fee Amount (Rs}  Balance Amount (Rs)

Amount {Rs) 1|

Fee type

Liability ledger Amcunt (Rs)

* Total amount (Rs) < |

&9 Save * Clear

New Receipt can be added with Payment different Payment Methods like Cash,Cheque ,DD ...

If Payment Method is selected as Cheque Cheque No and Date fields will be enabled and Data could be added.

BUILDERS
Nathakadaiyur, Han
Tirupur Dt Tamiln

yam-638 108,
aduy, India,
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Advance Payment

“ Payment data : (4/04/2022 ﬁ:;! * Daposit type © Selmr‘w :‘ j_ji_ j::
* Payment mode: Cheque > Institution ;| BUILDERS ENGINEEﬁING COL YAsseta/c: 4
“Chequza no. r—_———-E *Chegue date: iis
Bankname - %] *
Remark :[ |
Fee details :
Course Fae type Fze Amount (Rs) - Balance Amount (Rs)
 Feetvpes| - e 700 | ions
Fee type Liability ledger Amount (Rs}
T i S s ;‘otal amount (Rs) : E
8 sove] ¥ Clear |
A g U TR R SR e ol RO b Y i Fictk i ]

When Payment Type is selected as DD the DD no and DD date fields will be enabled and the details could be
added.

&

Advance Payment 3
* paymant date : 04/04/2022  [35] “ Deposit type :  Self .
* Payment mode : | Demand Draft 7 Insstution ;| BUILDERS ENGINZERING COL “AssetA/c:[108 -]
* DD no. :i l * DD date: :,"“' A y y @
Bank name l ¥ 7 - | @
Remark :l ]

Fee details :

Fee Amount (Rs)  Balance Amount (Rs)

Course Fee type

Fea tyos t .l Amount {Rs) : __J ‘&ugdd
Fee type Liability ledger Amount (Rs) t

* Total amoﬂnt (Rs) : {

o

{5 KANGAYAM {'-
3| 638 108. g}}
¥z
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Once the Receipt details are and Saved the Receipt will be displayed.’

-» ELANGO M

BEC231

Receipt details :

un 2021-May 2022

s

The Receipt could be viewed and Print.

Receipt no. . Date Deposit type. Payment mode Remarks Payment Ameunt (Rs)  Deposit Amount (Rs.}
15/06/2021 Self Cash ADMISSION FEES {207 5,000.00 -~ [
........... -4 it Mg - S o B il
Return details : Total Received Amount (Rs) : 5,000.00
Date Payment mode Chequa/DD no. Bank name lemarks Amount (Rs.)
Converted to student advance : Total Return Amount (Rs) : 0.00
Recaipt no. Dat= Remarks Amount (Rs.) |
i
| SSw— - e e . ~——
Total converted amount (Rs) : 0,00

BUILDERS ENGI
Nathakadaiyur, i
Tirupur D7

ayam-G38 108,

Akt fndia
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Print fee receipt PANY

BUILDERS ENGINEERING COLLEGE
{ISO CERTIFIZD & ACCREDITED 3Y NB8A)
"\, ( Erode Road,Nathakadaiyur,, Xangayam,, Tiruppur, Tamil Nadu - 638 108
BUILDERS Phone : 4258241545, Fax :+91-421-2334453
e Email : info@buildzrscollege.edu.in Wsbsite : http://builderscollege 2du.in

FEES RECEIPT

Name: ELANGO M Date : 15/06/2021 R.No.: FCECADV245 =
Roll No. BEC231 Apclication no : FOE_202123!Course: BE - MECHANICAL ENGINEERING Semester :
Particulars Amount (Rs.)
Admission Fzas 5,000.00
Rupees Five Thousand Only Total (Rs.) = 5,000.00
Payment mode :
Bank :

Student Advance Receipt:

° The amount paid by the Student as Candidate will be moved to Student Advance
o In other Case if Payment made by the Student is excess than the Demand the excess remaining Amount
will be moved to Student Advance.

Navigation: Fee Collection -> Transaction -> Student Advance Receipt -> New Receipt.

Nathakada!
Tirupus
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Advance Payment

= payment date : 04/04/2022 [‘:r‘; * Deposit type : ge;fv v
¢ Payment moda ;| Cash B Institution : BUILDERS ENGINEERING COL vAssetafc:[casH =
*Chaque no : CE T S *Chegus data:
Bank name : - =)
Remark:{

Fee details :

Fee tyos - Amount (Rs) :5 | -_JV Add
EE oo e - O ——
Fee type Liability ledger Amount (Rs)

* Total amount (Rs} ‘

t:j Sav; h tlea}

e New Receipt can be added with Payment different Payment Methods like Cash,Cheque ,DD ...

e If Payment Method is selected as Cheque Cheque No and Date fields will be enabled and Data could be added.

Advance Payment

* payment date | 04/04/2022  [35] * Depasit type : Seif -
* Payment mode : Cheque - Insttution : BUILDERS ENGINEERING COL ®AssetA/c: 3 =
?Cheque no.: % i *Cheque data: <dd/ M /yrryy > fis]
Bank name :| ! 13]
Remark:| i |

Fee details :

Course Fes type Fee Amount (Rs)  Balance Amount (Rs)

Fee type :| - Amount [Rs] :r : & Add
Fee type Liability ledger Amount (Rs)

* Total amount (Rs) : ;

e

Aveon Infotech Pvt Ltd

Rip

BUILDERS NG it
Nathakadaiyur, Kz
Tirupur Dt Ten

3 KA

(4]
C
NGAYAM |
638 108. /&
by



CMS Application User Manual | (CMS)

o  When Payment Type is selected as DD the DD no and DD date fields will be enabled and the details could be
added.

Advance Payment

* Payment date : 04/04/2022 @

* Deposit type : Self Y.
* Payment mode : Demand Draft S Institution : BOVILVISEVRS ENGINEERING COL “AssetAfc: 108 ¥
‘DDno.:[ ] « DD date : <dd/MM/yyyy> [15)
Bankname 1 | Ef]
Remark:{

Fee details :

Course Fee type Fee Amount (Rs)  Balancs Amount (Rs)

- Amount (Rs) ;| i+ A;{d

Fee type Liability ledger Amount (Rs)

Fee type |

“ Total amount (Rs) :

Esse 2 Cle

e  Once the Receipt details are and Saved the Receipt will be displayed .
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| BUILDERS ENGINEERING COLLEGE 2

IS g . 1o arven

* Roll no. 1 113CIV068 | Name:DHARMARAJAZ  Batch: CIVIL2013-17

Receipt details :

Receipt no. | Date Deposit type Payment mode Remarks Payment Amount (Rs) = Deposit Amount (Rs.)
29/06/2013 Candidate Advar Cash IMECH ADVTF. 59,000.00 7 o

e R i s :
Return details : Total received amount (Rs) : §9,000.00

Date Payment mode Chagqua/DD no. Bank name Ramarks Amount (Rs)
Payment made from advance : Total return amount (Rs) : 0.00

Recaipt no. Date Remarks Amount (Rs) i
| » FOE4053,800K1581 15/08/2013 99.000.C0

e The Receipt could be viewed and Print.

Print fee receipt A

BUILDERS ENGINEERING COLLEGE
{ISO CERTIFIZD & ACCREDITED BY NBA)
K ( Erode Road,Nathakacaiyur,, Kangayam,, Tirupour, Tamil Nadu - 633 108
BUILDERS Phons : 4253221545, Fax : +91-421-2334453
—— Email : info@ouildzrscolizge.aduin Websita : http://builderscollzge. edu.in

FEES RECEIPT

Name: DHARMARAIAB Date : 29/05/2013 R.No.: =
Roll No. 13CIV0&8 Course: CJVIL2013-17 Semester : &
Particulars Amount (Rs.) |
TUITION FEES 99,000.00
Rupees Ninety Nine Thousand Only Total (Rs.) ¢ $9,000.00 1.6 |
Payment mode : ; g |
' Bank:

e
BUILDERS ENGIN
Nathakadaiyur, Karc:

Tirupur Dt Tami!
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Student Fee Receipt:

° In Student Fee Receipt Form the pending Fee details can be viewed and the Payment could also be done.

*Rolf no - [21CSECO2 Name : ABINAYA S Batch : 8E - CSE 2021-2025

Contactno: Status: Active Bearding type: Day Scholar Community: Caste:

*Paymant sourca ;| Saif v "Paymentmethod: Cash e [ “Payment date : 04/04/2022 i)
¥ Ledger: icAsH - vance | P:aymfn_twt_o_ad»vance"
* Pay amt (Rs) - lo Add Pa/ment] Fee nama: i ARGEALE i
T S AT '
7 5
Pay? Year e Sem. © Fee name | Fae amt (Ks) Con. amt (Rs.) iy Pay amt (Rs.) Balance amt {Rs,)
4 1 jun 2021-May 20Z 1 TUITION FEES - 2 50,000.00 0.00 0.00 0.00 50,000.00
g 1 Jun 2021-May 202 1 BEC - TUTION FE 50.000.00 0.00  25,000.00 0.c0 25.000.00
Recaived amt (Rs}: Toadvance2 amt (Rs) . Paymentamt (Rs}: Ba|ance amt (Rs) 2
ikt ‘5'375“5, k- ’Cltari il

e New Receipt can be added with Payment different Payment Methods like Cash,Cheque ,DD ...

e If Payment Method is selected as Cheque Cheque No and Date fields will be enabled and Data could be added.

| KANGAYAM =
i 638 108. /Q

Mat hakadawur
Tirupur DI, 13
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[N Excssouz

Name : AZINAYA |

£ - CSE 2021-2025

Contaztno®  Status: Achve BSoarding type . Day 5cholar Community @ Casta
‘osymantsourc: | Seff > *Paymentmethod: Cheque ? : tpaymantdate | 04/04/2022 (15
* Ledger: | - Va;men:; from pqyance. Paymentloudvance
*Bank nama : %) “Chegueno.: | *Cheque date : <cd/MMiyyyy> j'éj
* Payamt () {0 } Add Paymentl Fazname: Amount . [ }
i Academic Received [
Pay?  Year ! Sem. | Feename Fee amt (Rs.) Con, amt (Rs) 12 ll(Rs.J Payamt (Rs) | Balance amt (Rs) {
» oy Jun 2021-May 207 1 TUITION FEES - & 50,000.00 2.00 0.00 0.00 50,000.00 !
fF 1 Jun 2021-May 202 1 BEC-TUTION FE 50,000.00 000 25,000.00 Q.00 25,000.00
Recaived amt{Rs}: Toadvanczamt(Rs}: Paymentamt(Rs): 2alance amt{Rs):

Remarks : L

*Roll no : i21CSE§OZ

—— e

Contactno:

‘Payment sourcz

* Ledger:

* Bank name

Status: Active Boarding type : Day Scholar Community @

Name : ABINAYA §

Batch - BE - C5E 2021-2025

Casta :

Payment to advance|

* Pay amt(3s)

—

*Payment date : 04/04/2022 @

| @— 'Duno.:‘_______}"m date 1 <ded/MA

Fea pame: r E Arount i _I
5 Acadzmic Received
Year Vearl Sem.  Fee name ‘Fee amt (R;.) Con. amt‘(Rs.) amt Rs) Pay amt (Rs)) Balance amt (Rs.)
¥ 1 Jun 2021-May 202 1 TUITION FEES - ¢ 50,000.00 0.00 0.00 0.00 50,000.00 |
1 Jun2021-May 20Z 1 BEC - TUTION FE 50,000.00 0.00  25.000.00 0.00 25,000.00 I
Received amt (Rs) : Toadvanca amt{Rs)© Paymentamt{Rs): Balance amt(Rs):
Remarks :

e R
Aveon Ir}fg@é Pyt-Lid:
i

(8 seve. % Clear]

Page 65
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Last Receipt -> The previous Receipt details for the Students can be viewed and can be Print.

Print fee receipt

BUILDERS ENGINEERING COLLEGE
(15O CERTIFIZD & ACCREDITED BY NBA) ‘\
Erode Rozd, Mathakadaiyur,, Xangayam,, Tiruppur, Tamil Nadu - 638 108
Phon=:4258241543, Fax:+51-421-2334453
Website : http://buildarscollegz.2du.in

Email : info@buildarscolizge adu.in

FEES RECEIPT

I

Date: 29/10/2021 R.No.: FOE407

Name: ABINAYA !
Roll No. 21C5E002 Course: BE - CSE 2021-2025 Semester :1
Particulars Amount (Rs.)
SEC - TUTION FEES {GN) - 2021 25,000.00
Rupees Twenty Five Thousand Only Total (Rs.) : 25,000.00 |
Payment mode : Cash 7
Signature of tha Authority =

Student Fee Apply ->In Student Fee Apply form extra Fees like ID Fine could be applied for the Student

'CAN G/’"‘.‘i’.“:‘
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Student Fee Apply

Samastar: 2 v Apply date: 04/04/2022 E

Feztype: | BEC-OTHER MISC, FEES v Feedescription:

| Amount (Rs): n

Add

Select? Name Dascription Payment amt (Rs)

R ‘ o Apply | Clear

o [Edit Fee Detail ->In Edit Fee Detail the Fee applied for the Student can be Edited
The Applied fee will be Edited in case of Concessions.When the Student receive Concession in Fees.

Quota : Management Quota Boarding type : Day Scholar Status : Active  3us stop

Student Fee Deatails  8oarding Details

|

Fae natua:i\}lﬁ_ R “'ﬂ‘

Year | Sem  Fee category Fae desc Feestatus  'Date P:;: Rs) A(;:)unt C:::(e;:;m Billad?

4 FeeStatus: Charge @items) Ui ettt el s L I L e

e 1 Tutonfee || TUITION FEES-2021 Charge 01/09/2021 50,000.00 |

1 % BEC - TUTION Fiés‘ BEC - TUTION FEES (G Charge 01/08/2021 25,000.00 50,000.00

4 FaeStatus: Billad (2 items)
1 1 BEC - ROOM AND E¢ BEC - ROOM AND 267 Billed 01/05/2021 20,000.00 20,000.00 Y
1 1 BEC- MESS FEES  BEC - MESS FEES - 20; Billed 01/09/2021 30,000.00 30,000.00 ki s

R
e
.
I

Total balanca faz {Rs.) £ 75,000.00  Total f22 paid {Rs.) : 75,000.00 Total deposit balancs amount (Rs.) : 10,000.00 last Receipt  Fza A;i;lyf

1B Save! (% Clear |

VGINEERING 0O [ £
yur, Ksngayam-ﬁSBl-ﬁgg :

wi8milevaa. .
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| Quota: Management Quota Boarding tyoe : Day Scholar Status ; Active  Bus stop:

Student Fee Details  Boarding Details

Faa status ;|

e sl A L e

i - Year Sem Feac A il
{ Concession Fee Confirmation

it &esgmﬁ: Qh@raz QJ Concession amount (Rs.) © :
¥ 1 1 Tutio e

% . BEC Concession givan by y " i =i

4 FasStatus: Billed (2t
1 1 BEC -

Concassion Reason ©

1 1 BEC-|

Total balanca fa22 {Rs.) : 75,000.00 Total fz2 paid (3s.) = 75,000.00 Total deposit balanca amount {Rs.} : 10,000.00 Last R:»ggip_t\‘ l»F:e _Applyli

B save) [l Clear

° In Boarding Details pop up the Boarding Details of the Student can be changed .
° Once Boarding Type is changed the The Fee can be applied automatically.

BUILDERS ENGINEERING COL ~ & 6 7 cla1cse002 Student - ABINAYA e

Quota: M. t Quota ding type : Day Schalar Status: Active  Busstop: |

Student Fea Details  Boarding Details |

Boarding type Hostel Room Startdate | End date i e J Boarding type - Hostaller by

» Day Scholar 01/06/2021 ! * Hosta! i e _ -‘ | ‘

‘ | startdate: 04/04/2022 [35] [

Applied Fees ‘BSE:; 5 C_I;_qy_é

Year  Semester Fea t}pe Fee desc Fea status Paid amount {Rs)  ‘Amount (Rs) Billed? ;
ARG
Aveon Infotegh Pyt Lt P : Page 68
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33. ADMISSIONMODULE:

1. Candidate Enquiry:
a) Candidate Search
Navigation:

Admission -> Enquiry -> Candidate Search -> Select Institution -> from date ;

To date -> Necessary Candidate Detail column should be selected -> Download -> The candidate details within the given
period will be containd in Excel.

“fastitution

ERODE

Candidates source

# Only paid candidates
Available columns
8 | Group

&  profile (65)
P

P

{
|
! Profile
| Profite

Profile

;‘Pm#zle
} Profile
| Profile
f
selected cotumns
v B iGroup

=] ' Profile (7}

erofile

QNAL TRUST

< All candidates

*From Date

Column

Rolt No.

First Name
tastName

Father First Name
Father Last Name
Gender

Religion
Lommunity

Caste

Column

Foll No.

Last Name

Fathar First Name

Date Qf Sirth

01/08/2031

BUILDERS ENG
Nathakadaiyur,
Tirupur DL,




CMS Application User Manual | {CMS)

b) Candidate Enquiry
Navigation:

Admission -> Enquiry -> Candidate Enquiry -> select Add button -> New candidate entry form will be displayed to
Add new candidate.

ADMISSION | CANDIDATE ENQUIRIES | NEW CANDIDATE BUILDERS ENGINEERING COLLEGE
Candidate Enquiry Admission Year:2021 - 2022
Basic Datails
o e tast MNam
I
‘i Gende: h Blced Group o
| % = .
Nationality Religion Community
| v v v v
Casta Mooile Number Email-ld
|
’: Aaghar Ne ™
Parent Details Address Details
Addrass 1 Addrass 2 Ares 7 Locality
| Type  First Name Last Name Mobile Number Action |
Father r ; |
| |
| = 5 i |
Mother 2 | City Pin Code District
% s T
i i
{ J
Cualification Details O Add
Course Type Education Type Board Register No Mark Percentage(%) Action |
</ v v v s |
ot ¥ v ~ s
e LIS Preference D Q Add
Adm Categary Remarks
v taragam v v v :
™ C) Hestelter 2 Shift Course Category Course / Program Action
- O Host i
5 :
Bus step | "Mustaddic references Clisk Hare

¢) Candidate Enquiry
Navigation:

Admission -> Enquiry -> Search a Candidate name -> if you click the Action button -> Convert to student

PAs]
PN
a

-Kar,um m-638 108..
¢ Tarmiinadi, india.
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Candidate Enquiry:

ADMISSION ~ ADN BUILDERS ENGINEERING COLLEGE

Candidate Enquiries

App Ne. Year
2 200 A v
Aadhar Numbe
| Search resuiss g,
Enquiry Date App No. Name 12th Reg No. 12th Mark Parent Mobile  Candidate Mobile  Attended By Advance Return Amount Remark Actions
£9-07-2021 KAVIYAA R - RAGULM 10000 -
KAVINN - RAGULM 3000 "
KAVIS] - PAGULM 3000
O on
RAGULM 5000 -
RAGUS 0c e
Dalete
], Add Enguiry
Student Convert Form:
BE - CIVIL ENGINEERING - (General}
: KAVIYAA R
BEC3S52
FOE_ 2021352
Management Quota
Admission type + Regular
Batch™ Adraission Category
v v Management Quota v
Financial Category ~ loining Date ™
Rt st v 26022022 s
Hostel Routa Busstop Language Subject
~ v

Seholarship €

Cancel )

Page 71

BUILDERS &I
Nathakadaiyur, I€

Tirupur D, Tamiinady, India.
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Advance Refund option:

Advancs Amount
Payment Mode ™
Bank Nams *
Chequz No.
Pay To

lamarks

# Advance Type

10000
b4
KAVIYAAR
Advance Balance (Rs)

Return Date

Asset Ledger *

Chegue Date ™

Advance Account

Total Return Amount (Rs)*

a
B

&t

Amount (Rs)

0

BUILDERS ENCY
Nathakadaivur, €
Tirupur Dt T2
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Student:

a) Student Detail modification:
Navigation:

Admission -> Student -> Student Management -> Select institution -> Degree Program -> Batch -> you find the
Student list regarding to the concern degree and batch -> Action -> View -> Student Form will be displayed -> modify details
required and save.

ADMISSION © STUDENT MAr ENT BUILDERS ENGINEERING COULEGE
Student Profile Management °
Dupartment” Sagree dregram Bauh 2l Ne

A DS ™,

esbtAd AN

STUDENT'S LIST

s Photo ' Rall No. Name Gender DoB Blood Goup Parents Mobile No. Action
1 2140001 ABRAMIM Famaia 07, Dee 2063 - von
2 1140002 s81Y Mol eos |
i
i
3 DEERAKKUMARK Male 28 n 204 wes |
[
4 2180004 CHANASEKARAN SA Male 37, Aor 2004 sse '
Student Profile Form:
ADMISSION .~ 5 VENT . AIDS 2021-2025 BUILDERS ENGINEERING COLLEGE
Student profile
General Detalls 8 &
Campus Grade Reg No. 3 - J -
Date Of Zinth Gender Blood Group -
Date Of Joining : Boarding Route Name
ABIRAMIM Narionality : . Admission Categony Qo
21A1D001
BE-AIL&DS [ i . N
Family Details L4
£ Relation Type Mame Occupation Mobile Emall
1 Father
2 Mather 5
& & = & L+ a8 , 4 e M
Contact  Identity  Medicallnformation  Qualification  Certificats  Otbers  Guardian  ExtraCurricular o~ Curricular  NAAC Activity
Contact Details ! (+]

atﬁakadaiyur, Kar

TIUpur Dt Tamiinas. . o000 108,
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MANSITSCUY  ADS 20112038 BHLLERS ENGINTERING OLLERE
Student Entry

~; a
0

Student Action :
Navigation :

A) Admission -> Student Action -> Student Disciplinary Action -> select the institution and program ->the
student list of disciplinary action will be displayed.

* Program

tivue

CLORRS ENGINFERING LO1LEGE v { HECOMPUTER SCIENCE AND ENGINEERING vl
eatch Register Na, Roll Mo, Name Type srom Ta  Exp Return Date Action
TXBL4 L5008 ERILP G Gepartment Chae e el
KAITHIKEYAN & Giscontivue s (M
KUMARA Siscontoue 2 w:
245 Not Used ARRTHIC Sconteue 2
SCHIANTAS Nl
GOWTHAM Prwertiment Changs b ¢ “
Discontrue s (8l
s |8
i
8 |&
NILCHAR HISHA RS Ditcant rus 8
RANJTH KUMARY Discontinus a .
NAVIN N L Alsent a 3:
AANSTH S Cotlege Transfer 8| {
a i

s

i
BUILDERS Exy NE
Nathakadaiyur, Kan

Tirupur Dt, T
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Student Certificate Tracker:

Navigation:

Admission -> Student Certificate Tracker -> you can add new Certificate request.

Issue Date Remark |

34.Exam Module:

Exam Evaluation:

Navigation

Exam -> Exam Evaluation -> Semester Exam Result Upload -> you can do bulk upload of Semester
Result marks in the format provided.
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| Upload Semester Result Marks(Dote Formit)

*Institution

BUILDERS ENGINEERING COLLEGE

*Semester Result Marks File

Chgesa File | o file chosen

Select a pdf fila that contains semester result marks list

" Academic Yesr

i
i
i
1
* Academic fear Semester }
|

Jun 2021 -May 2022 v EVEN .

*Semester Subject Map File

0058 File | to file chosen

v file that cuntains semester subject list.

Semester Result Marks File

Chocse File | o fitz chosen

Select a cav file that contains sem

Upload &a

esuit marks tist. Click here to dow

Exam Grade System / Mark System:

Navigation:

Exam -> Exam Grade System/ Mark Sheet -> Mark Defenition -> select Institution -> Mark Defenition can be

created and modified.

“Institution
BUILDERS ENGINEERING COLLEGE i
g

1 CSEFinal Year Project X
o Efgd v &
o EREMETAGROE0/80]

@ Internal{ 10.00 - 20.00}

o Attendance {0.00 - 5.00)

o Model {50.00 - 100.00}

& TEST{0.00-15.00)
ENGINEERING THERMODYNAMICS X
ENGINEERING THERMODYNAMICS X

Other Activities X

o oo

Project Work X

Mark Category

Mark Dafinition Mark Component Sub Component
* Code ' Name
£ng Eng 2011
 Min Mark = Max Mark
- L i (3 Embedded €7 Max Ratio Mark

cor [N

R!

BUILDERS ENGINEERING CC
Nathakadaiyur, Kangayam-bsn
Tirupur Dt., Tamilnady, India.
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Exam Module :

Mark Definition:

Navigation: Exam -> Exam Grade System/ Exam Mark System -> choose the Institution and Mark Definition , Mark
category and mark component can be added.

Exam Master:

Navigation -> Exam -> Examination -> Exam dashboard -> Exam Master Form The Exam Details and Course for
which Exam will be conducted can be added and schedule for the exam can be updated.

EXAM  EXAMS © DXAM MASTER G.L.M, ARTS COLLEGE[AUTONOMOUS)

Exam Master

Internal Mark Entry:

In Individual Staff Login who handle the Subject
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Navigation : Academic -> Subject Card -> Subject (Action ) -> Internals select the Exam (Action) -> Mark Entry

Individual student Name will be listed and Mark Entry cold be done.

|| Mark Entry

|

q 2 @ 1922K1252 Apfresn §

i e

3 @'* 1922K1253 Abinaya s
4 - 1922K1254 Apirari V

-
5 i, 1922K1255 Aizhwarya J
-

5 @ 1922K 1258 Anjitha M
7 ‘s‘ 1922K1257 Anusha Shelina L
3 @ 1922K1258 Arthi 8
9 [N 192211259 Ashwini A

‘ &

8 0 ® 1922K1260 Berciya P

:

i %‘* 1922K1261 Bharani Priys P
12 @ 1922K1262 Bhuvaneshwari R
13 @ 1922K1263 Brindha R
14 @ 1922K1264 Dhinushiya 2

§

Ri
BUILDERS ENY;
Mathakadaiyur, i
Tirupur Dt



